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 Enter your sign in information at the log book. 
 

1. Turning on the system 

1. Switch on the Main switch (labeled 1 and 2) 
mounted on the wall and workstation (labeled 3). 

Switch 1- power supply for microscope 

Switch 2 – power supply for CPU & scan head 

Switch 3 – CPU  
 

2. Log into the user account “DBS Users”. 

→ Password: lsm900 

Sign in with your PPMS account credentials at the 
PPMS login window (light blue). 
 

3. Check the touch screen of the microscope, 
“Microscope”-> “Objective”, make sure position 6 
is selected (5x) 

         
 

 
 
 

2. Start Zen Blue 3.1 Software 

1. Double click the Zen 3.1 (blue edition) software 
icon on the desktop.  

2. Select “Zen System” to initiate the confocal 
component  

 
When switching ON the system from step 1, the 
calibration window will appear after starting the ZEN 
system software. 
 
If you are the first user of the day, you will need to 
calibrate the stage. 
 
Click ‘Calibrate now’ in the pop-up window. 
 
 
 
 
 
 
The second pop-up window will appear. Wait until the 
calibration is completed to proceed. 
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3. Setting the Microscope and Locating the specimen (Bright field and fluorescence illumination) 

1. Use ‘Locate’ tab to check your sample by viewing 
through the eye piece or camera.    

 

2. On right side of panel, find “Microscope” module and 
select appropriate objective to examine the 
slide/dish.  
 

3. Add one drop of appropriate medium (water/oil) 
onto your sample if objective (63X) is to be used. 

• Never put oil on Air/Water objective!!!  

• Note: Please make sure there is no oil or water at 
all on your slide when you are using air objective.  

• Any incorrect immersion medium /contamination 
will deteriorate image quality! 

 

4. To set the microscope for brightfield observation, 
click “Transmitted” button 
 

5. For DIC, refer to “Setting up DIC Image in OCULAR 
imaging mode”  in this manual 
 

6. To set the microscope for fluorescence observation, 
click on the following button for their respective 
emission channels:  

• DAPI → Blue emission 

• GFP → Green emission 

• Rhod → Red emission 

• CY5 → far-red emission  

 

7. Move the area to be observed right above the 
objective lens using joystick. F1 button on the joystick 
to changes the movement speed.  
 

8. To change focus: 

a. Use the handwheel on the microscope 

i. Clockwise → objective up 

b. Hold “Ctrl” on the keyboard while scrolling with 
mouse (Only use in LSM mode) 

 

9. To change the LED light intensity, go to “Colibri 5/7” 
to select the LED light and change the output power. 
  

10. When not observing the sample, click on “ALL OFF” 
to prevent photobleaching of the sample 
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KOHLER ILLUMINATION AND DIC SETTINGS 

The following steps are for KOHLER ILLUMINATION that is performed to ensure transmitted light focuses on the 

specimen, before DIC phase contrast imaging. 

 

 

Kohler illumination 
 

1. Ensure that the point of interest is in focus 
 

2. Close field stop [1] so that you can observe the field 
 

3. Align the condensor height [2] so as to see a sharp 
edge in the hexagon field 
 

4. Move the alignment metal knobs [3] until hexagon 
is in center of the field of view 
 

5. Open field stop [1] until you stop seeing the edge 
 

6. If necessary, adjust the condenser APERTURE STOP 
[4]. Remove one eyepiece lens and visualise the 
hexagon 
  
Note: When the Aperture Stop is fully opened, the 
Highest Resolution is achieved 
 
The default value set for the aperture stop (80%) in 
the Microscope control is such that contrast, and 
resolution are balanced out for each objective  

 

 

 

Field Diaphragm 

Condensor height adjustment 

Polariser 

Field alignment knobs 

Aperture Size control 

2 

1 

3 

4 
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Setting up DIC Image in OCULAR imaging mode 
 
1. Under “Locate” tab,  

Select the appropriate settings for DIC based on the 
objective being used:  

• DIC 2 – 10X, 20X 

• DIC 3 – 63X objectives 
 
 

 
2. Engage the polarizer (silver knob) to 0 degree (left most) 

when observing through the ocular mode.  
 
 
 
 
 
3. Turn the knob in the DIC prism slider (Located Right under 

the objective) to adjust the contrast of the image 
 
 
 
 
When switching to capture DIC image in LSM mode (using 
transmitted light PMT) 
 
When capturing the DIC image with the T-PMT detector using 
the laser LSM settings, the light is already polarised.  
 
Therefore, the polariser should be set to 90 degrees (right 
most), before acquiring images with LSM mode. 
 

 

 
 

 
 

 
 

 
 

 

4. Switching to laser scan mode:  

1. Before starting laser scan, cover sample with the stage 
sample cover provided. 

 
 
 

 
 

2. If you lift up microscope trans illuminator, laser will be 
cutoff. To resume laser, go to software->Acquisition-> 
Laser, click the “On” button.  

 
3. Make sure the laser box LED light is lit, indicating laser 

ON 
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5. Setting up the Scanning Track/Channel  

Method 1  
Load a predefined configuration with combination of 
different dyes from the configuration list box. The 
prefix of the name indicates: 

a) LSM: normal confocal scan 
b) SR: super-resolution airyscan 
c) MPLX: Multiplex 

 
 
This is followed by the laser to be used. “+”indicates 
the laser will be used simultaneously. “_” indicates 
sequential scan 
 
 
Method 2  
Open any previous image (image captured with 
LSM800/LSM900) with desired setting and click 
Reuse button in Dimension panel. 
 
 

 
 

Method 3 
Smart Setup 

1. Detection mode – to work with LSM 
confocal or airyscan mode 
 

 
 
 
 
 

2. “+” Select the dye/dyes to image from the 
list and select the pseudocolors. 
 
 
 

 
 

3. Select one of the following, and click APPLY 
a. Fastest – The fastest solution 
b. Best signal – to get the best signal 

with low cross-talk 
c. Smartest (line) – changes lasers after 

each line (good for live cell imaging 
with multiple colors) 
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Verify light path and scan settings 

1. In Imaging setup window, check: 
a. Emission range. 
b. How many detectors have been engaged? 
c. For simultaneous scan, more than one detector/laser 

is engage for one track.  
d. Picture on the right shows: one detector is engaged 

and emission range is 550-617nm. 
 
 

 

 

 

 

 

 

2. In Channels Window, check: 
a. Desired channels boxes if necessary. 
b. Lasers selection: select proper laser for excitation 
c. Laser light power: start from low, e.g. 0.05%  
d. With “High Intensity Laser Range” box is checked, 

you may push the laser to high power laser. 
Otherwise, laser power is limited to 0.01- 5%.  

e. Pinhole: Set the Pinhole to 1 AU (Airy Unit).  

• For colocalization studies, adjust pinhole of each 
channel to the same Optical Slice Thickness (µm 
section) as the reference channel.  

• If signal is very weak, select “Max” to locate the 
signal, before reverting pinhole to previous size 
for acquisition 

f. Master Gain: start from 600 for normal confocal and 
800 for airyscan 

g. Digital Offset: start from 0. 
h. Digital Gain: leave at 1.  

 
 

3. In Acquisition Mode window, check: 
a. Pixel size: Highlight “Confocal” to follow Nyquist 

Sampling  
b. Scan speed: Max, or 1µs - 2µs for pixel time 
c. Direction:  

• Bidirection for fast imaging; Uni-direction for co-
locolization studies. 

• Use autocorrection before acquiring image if bi-
direction scan is preferred.  

d. Averaging: increase this value to increase SNR but 
may introduce photobleaching. 

e. Bits per pixel: 16 bit, if file size is not a concern. 
 

4. Repeat step for other channels.  
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6. Optimizing imaging parameters and image acquisition 

1. Activate Range Indicator. The scanned image appears in a 
false-color presentation. 

• Red pixel = saturation (maximum intensity) 

• Blue pixel = zero (minimum intensity).  
 
 
2. Select one channel and click on “Live” for continuous fast 

scanning and observe the intensity curve present in 
Histogram window.  

• AF Find Focus – To find the best focus automatically 
based on intensity profile 

• Set Exposure – automatic pre-adjustment of the 
detector gain and offset 

• Live – continuous fast scanning (for finding and 
focusing on the sample) of the selected channel. 
Frame size will be 512px x 512px 

• Continuous – continuous scanning with selected scan 
speed. Scans all channels and displays as overlay. 
Select the different displayed channels under 
“Dimensions” tab, then Channels 

• Snap – for recording a single image 

• Stop – for stopping the current scan procedure 
 

3. Optimize image as below:  

• Fine-tune the focus with the fine adjustment knob to 
the brightest or preferred z- position. 

• Increase Master Gain (Maximum of 800) until a few 
red pixel (indicating saturation) appear in the image; 
Increase the Laser Power, if increasing detector gain 
cannot achieve the saturation or desired intensity;  

• Decrease the Digital Offset to reduce background 
signal until the desired background region is filled 
with some blue pixels 
 

4. Go to next channel to repeat step 1-3.  
 

5. Acquisition Mode-> If necessary, change Crop Area 

• When cropping area, there is a higher chance of 
photobleaching as the sample will be exposed to laser 
for a longer time. However, scan speed will be faster 
 

6. “Snap” to capture image. If Time series, Z-stack, or Tiles is 
required, click “Start Experiment” instead of “Snap”. 
 

7. You may activate “Autosave” function so acquired images 
will be saved automatically to the destination you have 
defined in the “Autosave” window.  

• If not, right click on the desired image in right column 
“Images and documents”, and select “Save as” 

 
 

 
 

 
By changing the area of the graph under the histogram, the 
signal is brighter on the screen. There is no change in signal 
value, and only causes the signal to appear brighter in the 
image. This is especially useful for specimens prone to 
photobleaching. Reset the graph to show true signal level 
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7. Setting up AiryScan Scanning 
 

1) Make sure 63x oil lens or 63x water lens is in use  
2) Refer to the following to setup light path and fine-tune 

scanning parameters: 

• 4. Setting up the Scanning Track/Channel 

• 5. Verify light path and scan settings 
 

3) Acquisition Mode→ Crop Area: set to x0.5 to have a 
larger view. “Live” to find interested area. Move the 
interested area into the center of the view.  

4) Acquisition Mode → Crop Area: set the area of scan ≥ 
1.3x (the larger area will require longer scanning time).  

5) Acquisition Mode → pixel size: Highlight “Confocal” 
 

 

6) Channel Window: Check only one channel and go to 
continuous scan 
 
 
 
 

7) Click on Airyscan tab on the central screen area. 
 
 
 
 
 

8) Click on Display tool tab (next to Airyscan) and click on 
“max/min” or “best fit” to measure the signal intensity 
range.  
 

9) Adjust the master gain or laser power to set the signal 
range spanning 1/3 to 2/3 of the histogram range 
(Don’t use Range Indicator).  
 

10) Set the other channel by repeating procedure 6, and 
11, 12.  
 

11) Check the optimal setting (frame size, speed, lens and 
scan area) following the warning notice details.  
 

12) Channel Window: check all the channels.  
 

13) Snap/Start Experiment and wait for the scanning 
complete before you preview with Airyscan during the 
scanning)  
 

14) After the scanning, go to Processing and choose 
“Airyscan Processing” on method window, select input 
image on (bottom) window, “Apply” to generate the 
final image with Zeiss deconvolution.  
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Multiplex Mode  
 

1. Under Acquisition tab, in the drop down list choose 
MPLX_4Y_EX405_488_561_640 
 

 
Note: This is the setting for multiplex acquisition to activate 
super resolution scan with parallelization of 4 lines in the Y-
direction.  
 
Note: To use other multiplex modes 2Y (in case you need 
slightly better resolution in multiplex with super-resolution) 
MPLX_2Y and SR-2Y settings will need to be chosen. 

 
 

 
 

2. Under Acquisition mode, set Sampling as SR-4Yz 
 
Note: This sets the xy sampling set for 2x Nyquist to achieve 
4 parallelization lines in super-resolution imaging 
 
 
 

3. Go “LIVE” 
 

4. Refer to the following to setup light path and fine-tune 
scanning parameters: 

• Setting up the Scanning Track/Channel 

• Verify light path and scan settings 
 

5. Focus on the Region of Interest  
 

6. Ensure that the detector is Green in color (Status:ON)  
if not wait until it is turned ON. 

• If the issue persists, the laser power may have 
been too low for the detector, and so adjust the 
laser power /gain accordingly.  
 
 

 
7. Check that the message ‘Airyscan Acquisition is 

optimally configured’ appears.  
 

8. STOP the live scan 
 
 
 
 
 

9. Click Snap button 
10. Image is acquired 
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11. To save the raw data file, 

• If autosave in enabled, under “workspace tab”, 
select ‘save’ icon.  

• Or not, right click the image and select “Save as” 
 

 
 
 
 

12. To save image, under Processing tab 

• Under Method 

• Select “Airyscan Processing” 

• Select your image under Input 

• Click “Apply” 

• Save the image under Workspace tab 
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8. 3D volume scan 
 

1) Check the Z-Stack box in the main tools area  
 

2) Choose preference scanning mode: 
a. All tracks per slice: images one slice for each channel 

before next slice. Good for co-localization.  
b. Full Z-stack per Track: images one channel for all slices 

before moving to next channel. Fast imaging.  
 

 

3) Open the Z-Stack tool panel by clicking on the Z-Stack tab  
 

4) Choose a channel that have signal throughout the interest 
volume and then click on live  
a. Move to the best focus plane, then under “Focus” tab 

select “Set zero”. This helps to define the zero position 
of the plane of interest. This should not be done if the 
tile scan has been set up 

b. Use the focus knob to locate one end of the specimen 
and click Set First button. The Z value should be negative  

c. Then use the focus to locate another end of the 
specimen and click Set Last button. The Z value should 
be positive  

d. Stop the “Live”. 
e. Set the Interval  

i. Keep “Interval” 
ii. Select “Optimal”: This sets interval that gives 50% 

overlapping between each frame thus provide 
better 3D image reconstruction.  
 

5) Click on the Start Experiment button to start the recording of 
the Z-stack.  
 
 
 

6) 3D image data presentation:  
a. Maximum Intensity Projection:  

Go to Processing and choose the Orthogonal Projection 
in the methods. Choose the Projection Plane and 
methods then Apply.  
 

b. 3D image video: 
Click the 3D tab and activate Series tab, select the 
rotating axis at Render Series, number of frame and the 
angle. Select “360 Panorama” or “Partial Panorama”. 
Click Apply and the series images will be generated in a 
new tab.  
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Exporting the 3D data (after 3D volume scan) 
 

1. After acquiring the 3D volume data: 
a. File → Export/Import → Export 

 
 
 
 
 
 
 
 

b. Under Processing → Method Parameters, 
select the format and other parameters to 
be set for the export. 
 

c. Specify the destination folder you would 
like to export to 
 

d. Click ‘Apply’  
 
 

2. For 3D image video: 
a. Go to File → Export → Movie Export and 

then choose a suitable mode (file type) 
and adjust the playing speed in Mapping 
(Frame per Second) and save in your own 
folder. 
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Colocalization Study 
 

1. After acquisition, click on the Colocal. 
Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
2. Under ‘Coloc. Tools’ and ‘Dimensions’, 

select the frame of capture you would 
want to analyse 
 
 

3. The colocalisation map for each frame 
captured is shown as the graphical 
representation.  
The channels to be analysed for 
colocalisation can be defined in the 
horizontal and vertical planes, along 
with the threshold ranges to be 
quantified for.  

 
 

4. Using the ROI draw tools, you may 
select a region of interest based on the 
selection and analyse the particular 
ROI for colocalisation 

 
 
 
5. Once the colocalisation tools are set, 

select Coloc Tools -> Table to generate 
the quantified results from the 
colocalisation analysis.  
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9. Setting up Time Series Experiment 
 

1) Check the box for Time Series in the main tools 
area.  
 

2) Open the Time Series tool panel by clicking on 
the Time Series Tab  
 

3) Set the number of Cycle and Interval between 
each frame. (The scanning of each frame is 
included in the countdown of the Interval, 
therefore Interval time should ≥ scanning time 
of one multi-color frame)  
 

4) Set the channel and acquisition parameter as 
necessary and then click Start Experiment .  
 

5) After saving as CZI file type, video for the time 
series can be exported. Go to File →Export 
→Movie Export. Then choose Mode (file type) 
and define subset. Adjust the playing speed 
(Mapping) and select the destination and file 
name for export.  
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10. Tiles scan Setup: tile/Stake/Single Position 
 

1. Check the box for Tile in the main tools area.  
 

2. Open the Tile tool panel  
 

3. Click on “Advanced Setup” to view stage navigator.  

 

4. To define multiple imaging location by selecting Tiles, Size 
and/or Stake under “Tile Regions”, and/or Single Position 
under “Positions” after you move stage to the interesting 
position. Click on “+” to add tiles to stage navigator 

a. Tiles: Enter the value of X and Y to define the tile 
region. Eg: X=3 and Y=3 equals to tile region 
containing 9 tiles. 

b. Size: imaging area will be based on size in µm you 
defined. 

c. Stake: define an imaging area to cover all the markers 
you have added by “+”.  

• Click “+” to add the first position, then move the 
blue box around on the stage navigator and click 
“+” to add a new position. The map will be 
updated with the selected area (shown by yellow 
box) 

d. Single positions: click “+” to add current point into the 
list. For individual points of interest on the sample 
 

5. In Advanced Setup window, select “Preview Scan”-> 
“Start Preview Scan”.  
 
 
 

 

6. To add focus map into tile: Under “Support Points”, add 
focus map by following of the way list below:  

a. Manually add point: click on the Tile, move to one 
position, “Set Current X/Y/Z”. Repeat to add few 
more points if you need. 

b. Automatically add point for one tile: Click “Distribute” 
to add matric of points into the Tile, “Add support 
point at current stage and focus position”. 

c. Automatically add points for all tiles: Click “Set One 
support point into center position”. 

 

7. An example of using distribute 3x3 support points (yellow 
circles) into the tile.   

• It is recommended to have 5 support points, ie. at 
the 4 corners, and 1 in the center of the image 

• If too many support points are added, the 
generated image might look ‘patchy’ 
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11. Tiles Scan Setup: Tile Experiments (Acquiring image for Tiles scan) 
 

1) Tick the desired position from the Tile region 
list, such as TR1 and TR2 on the example.  

 

 

2) Click “Verify Tile Regions” to call the 
corresponding window which shows all the 
support points (SP) you have defined.  
 
 
 
 
 
 

3) Select the first SP and click “Move to Current 
Point”, adjust focus if necessary before click 
“Set Z & Move to next”.  Repeat for all SPs. 

 
 

4) Or you may click on “None manual 
adjustment” which will automatically find and 
update the best focus position for all the SP.  
 
 
 
 
 
 

 
 

 
 

5) Find “Focus Strategy” window, select the one fit 
to your experiment: “Use Focus Surface/Z 
Values Defined by Tiles Setup”.  

 
 
 
 
 

6) Before you start, under “Tiles” tab edit 
“Options” such as  
“Image Pyramid During Acquisition” 

 
 
 

7) Click on Start Experiment to begin the 
experiment  
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Experiment Designer 

1. Under Acquisition tab, Check Experiment 
Designer. 
 
The Experiment Designer Tab will appear 

 
 

 
 
 
 
 
 
 

2. Click ‘import’ to import the predefined 
experiment settings you would like to perform at 
each acquisition block 

 
 
 

 
 

3. In between, there are a few different blocks that 
can be added 

 
a. Add a “wait” block to add a block that delays 

experiment for a specific time and then 
waits for user prompt to continue with the 
experiment, 

 
b. Add “delay” block to add a block that delays 

experiment for a specific time.  
 
4.  For each acquisition block, click and go “live” to 

set the desired laser parameters and experiment 
settings you want to perform for that acquisition 
block 
 
 

5. Under “Loops and Repetitions” in the 
“Experiment Designer” you can set the number 
of cycles that blocks are to be repeated or 
looped about based on the sequence of 
experiments required for your design. 

 
 

6. After configuring the experiment design, click 
“Start Experiment” 
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7. The real-time blocks running can be visualized in the 
Experiment Designer tab 
 
When the experiment is at the “Wait block”, there is 
a prompt that says “Reached Wait block”. You may 
choose to “Continue Experiment” or “Stop 
Experiment” 

 
8. After the experiment is complete, under the 

“Dimensions” tab you can scroll to the different 
blocks.  

 
 
 

 
 

9. The rawdata of the experiment blocks have already 
been saved as czi files under: ThisPC\Pictures and 
under the folder of date of acquisition.  

 
 

• To export as images, go to “Processing tab” → 
“Batch” → ” Batch Method”→ select ”Image 
Export”.  
 
 
 
 
 
 
 
 

• Under “Batch Processing”, click “+” to select 
the czi files from which you would want to 
export.  
 
 
 
 

• Under “Parameters” tab select the format and 
type of the image you would like to export. 
 
 

 
 
 

• Click “Apply” to start export 
 

• The exported images will be saved under the 
same folder at which the raw data was saved 
in. 
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Definite Focus 
 

 
Definite Focus.2 is a miniaturized optical unit for detecting changes in path lengths resulting from cooling or 
warming of microscope components or samples (focus drift).  
 
Select this focus strategy to use the definite focus device to stabilize the focus in the Z axis, in the event of 
temperature fluctuations during your Time Series experiments. 
 
Definite Focus.2 can be used in different ways. The software control offers the possibility to use Definite Focus.2 in 
time-lapse and multi-position experiments and for tile imaging.  

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

 
Find Surface 
The Find Surface function assists the user in locating the 
sample in the Z direction. First, Definite Focus.2 adjusts the 
movable lens to a reference value. Subsequently, Definite 
Focus.2 moves the Z-drive downwards the working distance 
of the selected objective and then starts a successive search. 
If Definite Focus.2 finds a signal, the Z-drive is stopped. If no 
signal can be found, the process is aborted, and the objective 
is returned to the initial position. 

 
Store Focus / Recall Focus  
Definite Focus.2 allows to store and recall a relative Z 
position. 
 
This allows a sample to be focused or kept in focus, even if 
the sample container has changed its absolute Z position.  
 
Lock Focus / Interactive Mode 
The Lock Focus function is used to continuously monitor and 
stabilize a set focus position. This function is used to assist 
the user in locating an appropriate sample position by 
continuously monitoring and adjusting a preset relative Z 
position. 
 
If the distance changes due to a temperature deviation or 
tilting of the sample, it will immediately be compensated. 
The focus position to be monitored can be changed 
interactively. The changed focus position will be continuously 
monitored and adjusted. 
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3D multi-position scanning using Definite Focus 
 

1. Under Acquisition tab, choose the settings of the 
LSM scan mode you want to use 
 

2. Go Live  
Refer to the following to setup light path and fine-
tune scanning parameters:  

• Setting up the Scanning Track/Channel 

• Verify light path and scan settings 
 

3. Check Z-stack (doing 3D volume) and Tiles (doing 
multi-position). You may select Time Series if you 
would want to scan the sample over time as well. 
 
 
 

4. Under Tiles, under Positions add (+) positions you 
would want to scan at the multiple positions. 

• Note: Need not to be in focus when adding the 
positions.  
 
 
 
 
 

5. Click Verify positions 
Under Verify Positions tab:  
Click Move to current point 
 
 
 

6. In the ‘Select Verification Helper Method’ click 
Definite Focus 

 
 
 
 
 
 
 
 
 
 
7. Under Definite Focus tab, Click Find Surface. This will 

set the focus to the surface of the sample quickly. 
 
8. Adjust focus manually as to focus the sample to the 

area of interest. Press Store Focus 
(Note: The software will set the focus of this position you 
have set as a new reference for other positions as well) 
 

 
 
 
 

 
 
 

 
 

 
 

 
 

 

 



CBIS/DBS Confocal Core  LSM 900 Manual  27 Aug 2020 
 

Page 21 of 25 
 

9. Under Verify Positions: 
 

a. Click Run DF and Set Z. 
 

b. Use DF to verify the remaining to perform 
a fast focus along other points based on the 
set reference focus previously 

 
 
 
 
 
 

10. Under Z-stack tab 

• Set the range and slices parameters you would 
want to set for the acquisition 

• Note: The parameters you set for one position 
applies to all other positions as well.  

 
 

11.  For further fine focus adjust, manually adjust the 
focus of the other positions and Verify Positions - > 
‘Set Z & Move to the Next’ for each position.  

 
 
12. After setting all the focus, click Stop to discontinue 

Live position 
 

 
13. Click Start experiment button 
 
 
 
 
 
14. Save the raw data for further processing. 

 

• Under workspace, Images and Documents tab, 
select the image file to be saved as raw data  
 

• The raw .czi may also be exported as: 
File-> Export/Import-> Export. 
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15. To save as specific file type or custom options, 
 
a. Under Processing tab -> Batch 

 
b. Select raw image data under Input. 

 
c. Select the format options you require under the 

‘Parameters’ tab options. 
 

d. Specify how the images are to be saved and, 
Click Apply to save.  
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FRAP (Fluorescence recovery after photobleaching)  

1. Under Acquisition tab, check "Time Series", 
"Bleaching"  

 
2. Go Live 

Refer to the following to setup light path and fine-
tune scanning parameters:  

• Setting up the Scanning Track/Channel 

• Verify light path and scan settings 
 
 
 
 
3. Under "Time Series" tab you may define the 

number of images to be scanned (e.g. total 100 
images) and 0 time interval (scan continuously) 

 
 
 
 
 
 
 
4. To set the bleaching, Under " Timed Bleaching” tab 

(a) If bleach only one time, click "Start after # 

images" only. It defines the start of bleaching. In 

this case, bleach will start after the 10th image. 

(b) If bleach continuously, click “Start after # scans" 

and "Repeat after #images" (e.g. every 30 images). 

In this case, bleach will start after the 20th image 

and bleach repeats every 30 images. 

Define "iterations for area bleach" which indicates 

the number of bleaching repeated.  

 

5. Under “All Regions” define bleaching power by 
selecting active laser and its power (e.g. 100% at 
488nm) 

 
6. “Stop” live scan 
 
 

 
7. After completing the settings, click "Start 

Experiment" 
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8.  For online observation, click "ROI 

Mean" then select "Mean ROI"  

 

 

 

 

 

 

9. Select the region you bleach, Under 

“Experiment Regions” you may note 

the region you are observing for 

analysis 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10. In gallery observation, the green 

square indicates the bleaching time 
point frame being scanned.  

 

 
 
 

  
 

 
 
 

 



CBIS/DBS Confocal Core  LSM 900 Manual  27 Aug 2020 
 

Page 25 of 25 
 

12a. If there is user after you → Logging out of the system 

• Clean oil objective (with lens cleaning tissue only, but NOT Kimwipe)  
o Remove residue oil from the objective lens with a dry lens cleaning tissue  

o Clean the lens with a new lens cleaning tissue with 100% absolute ethanol  

o Dry the lens with another new lens cleaning tissue  

• Change objective to empty position (5x button on touchscreen control panel). 

• Exit ZEN Software (not just clicking on the cross to close the window), transfer data through CBIS 
Kraken or directly to shared workstation.  

o Wait for microscope icon at bottom right to disappear 

• Click on the logout button 
 

 
 

• Enter user log book according to Actual use time, report any issues faced. 
 

12b. If there is no user after you → Turning off the system 

• Clean oil objective (with lens cleaning tissue only but NOT Kimwipe)  
o Remove residue oil from the objective lens with a dry lens cleaning tissue  

o Clean the lens with a new lens cleaning tissue with 100% absolute ethanol  

o Dry the lens with another new lens cleaning tissue  

• Change objective to empty position (5x button on touchscreen control panel). 

• Exit ZEN Software (not just clicking on the cross to close the window), transfer data through CBIS 
Kraken or directly to shared workstation.  

o Wait for microscope icon at bottom right to disappear before shutting down PC 

• Do not need to click logout button, just shut down PC 3 as per normal 

• Switch off the Mains (labeled 1 and 2) mounted on the wall. 

• Enter user log book according to Actual use time, report any issues faced. 

• Cover the scope with Zeiss blue scope cover.  

 

 
 


